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1. Introduction
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This chapter describes the Relay Mimic Editor in general.

1.1. The Relay Mimic Editor window

The Relay Mimic Editor is used to create graphical mimic pictures, which can be 
sent to the relays. The mimic pictures do not have only a background image, but also 
dynamic objects and data points. Also LED indications and alarm LED texts can be 
defined.

The Relay Mimic Editor has a drawing area for creating the mimic pictures. The 
mimic pictures are viewed on the drawing area with the background image and 
dynamic objects. The size of the drawing area is 128 x 136 pixels which corresponds 
to the man-machine interface/mimic display in a relay terminal. The only possible 
colors at the moment are black and white.

)LJ�������� 7KH�5HOD\�0LPLF�(GLWRU�ZLQGRZ
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1.2. Graphical user interface elements

1.2.1. Menus

The Relay Mimic Editor has the following menu structure:

• File

• Edit

• Format

• View

• Options

• Help
2 ABB Automation
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1.2.1.1. Menu commands

The menu commands are explained in the following tables.

Table 1.2.1.1-1 File menu commands 

Command Explanation

New … Creates a new empty mimic picture replacing the current one. You can 
revert to the original picture by exiting the editor as long as you have not 
saved the new one.

Save Saves the device object’s mimic picture to disk.
Import … Imports a mimic picture previously stored on a disk. To apply the 

imported mimic picture to the current device object, you must save the it 
once.

Export … Exports the mimic picture to disk. The mimic picture of a device object is 
always stored with the filename ‘MIMIC.BIN’ in the ‘MIMIC’ subdirectory 
of the object’s home directory. For example: 
‘E:\CAP505\PRJ\SOST\OBJ0001\MIMIC\MIMIC.BIN’.
Note! After an export operation, the editor returns to display the device 
object’s mimic picture, not the one you have exported.

Print Setup... Opens a standard Print Setup dialog box.

Print Mimic... Prints the mimic picture just like currently shown on the drawing area. 
The comment text is also included, if defined in the options.

Print Dynamic
Objects...

Prints the definitions and icons for the dynamic objects and data points 
of the current mimic picture.

Exit Exits the Relay Mimic Editor. The changes can be either saved or 
discarded at this point.

Table 1.2.1.1-2 Edit menu commands 

Command Explanation

Insert Object->
COCB Opens a dialog box for inserting a dynamic COCB object to the mimic 

picture. See “COCB object (circuit breaker)” on page 8.
CODC Opens a dialog box for inserting a dynamic CODC object to the mimic 

picture. See “CODC object (Disconnector)” on page 9.
COIND Opens a dialog box for inserting a dynamic COIND object to the mimic 

picture. See “COIND object (indication)” on page 10.
COSW Opens a dialog box for inserting a dynamic COSW object to the mimic 

picture. See “COSW object (on/off)” on page 10.
CO3DC Opens a dialog box for inserting a dynamic CO3DC object to the mimic 

picture. See “CO3DC object (3-state disconnector)” on page 9.
MMITEXT Opens a dialog box for inserting a dynamic MMITEXT object to the 

mimic picture. See “MMITEXT object (dynamic point for texts)” on 
page 11.

MMIDATA Opens a dialog box for inserting a dynamic MMIDATA object to the 
mimic picture. See “MMIDATA object (dynamic point for numbers)” on 
page 11.

Edit Object Allows to edit the currently selected dynamic object by opening the 
dialog box through which the object initially was created.

Delete Object The selected dynamic objects are removed. The removal is confirmed.

Select Next 
Object

Selects the next dynamic object according to the defined selection 
priority.

Show Next Icon Shows the next icon of the currently selected dynamic object.
B Automation 3
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1.2.2. Tool bar and object bar

A short description of each tool bar and object bar button is shown in the following 
two tables. These descriptions can be viewed in the Relay Mimic Editor by resting 
the mouse pointer on any of the buttons for a short period of time. The description 
of the button appears in the status field of the status bar. These buttons are shortcuts 

Table 1.2.1.1-3 Format menu commands 

Command Explanation

Background 
Image

Opens the image editor for editing the mimic picture’s background 
image. See chapter “Image editor” on page 16.

Icons Opens the Icons dialog box for defining the current icon set. See chapter 
“Icons” on page 12

Alarm LED Texts Edits the alarm LED texts. See chapter “Alarm LEDs” on page 15
Comments Opens a dialog box for editing the mimic picture’s comment text.

Table 1.2.1.1-4 View menu commands

Command Explanation

Display Object 
Borders

A toggle switch for displaying or hiding the object borders on the drawing 
area.

Refresh Redraws the drawing area.

Table 1.2.1.1-5 Options menu commands 

Command Explanation

Include 
Comments to 
Printout

Toggle switch for including or excluding the optional comment text into/
from the mimic picture printout.

Table 1.2.1.1-6 Help menu commands 

Command Explanation

About Mimic 
Editor

Displays the version information of the Relay Mimic Editor.
4 ABB Automation
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to the corresponding menu commands.

Dimmed tools on the object bar indicate that the maximum number of objects have 
been applied. Likewise, a tool bar button is enabled only if the tool is applicable to 

Table 1.2.2-1 Tool bar buttons

Button Explanation

Saves the mimic picture to disk.

Prints the mimic picture.

Edits the selected dynamic object.

Selects the next dynamic object.

Shows the next icon of the currently selected dynamic object.

Edits the background image.

Opens the ‘Icons’ dialog box for editing the icons and working with the icon library.

Opens the ‘Alarm LED Texts’ dialog box for editing the alarm LED texts.

Table 1.2.2-2 Object bar buttons

Button Explanation

Circuit breaker object

Disconnector object

Indication object

On/Off object

3-state disconnector object

Dynamic point for texts

Dynamic point for numbers
B Automation 5
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the currently selected object.

1.2.3. Status bar

The following table explains the Relay Mimic Editor’s status bar items.

1.2.4. Drawing area

On the drawing area, dynamic objects and data points are displayed on top of
background image. The dynamic objects can be selected and moved around o
drawing area. The grid step is 8 pixels in both X and Y-direction when moving
dynamic objects. Double-clicking a dynamic object opens the edit dialog box fo

Table 1.2.3-1 Status bar items

Status bar item Explanation

Status field Displays status information.
Selected object Displays the name of the currently selected object.

Cursor position Displays the mouse cursor co-ordinates on the drawing area.
6 ABB Automation
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object.
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This chapter describes the dynamic objects and their configuration.

2.1. General

A relay terminal’s mimic view displays a dynamic object if it has been configur
using the Relay Mimic Editor. The object can be selected if control position is 
local mode. All four states and the object selection order (priority) can be configu
in the Relay Mimic Editor.

The object name defines the correspondence between the actual function bloc
the Relay Mimic Editor image. The logical behaviour is defined in the IEC 611
configuration while the component outlook is defined in the Relay Mimic Edito
The component name is the link between the two configurations.

The selection order is determined by the priority number. Objects with the sma
selection priority number will be selected first. If the selection priority is set to ze
the object cannot be selected from the local man-machine interface (MMI). 
Typically zero is the default value for indication objects.

The indication connection is a graphical feature used to visualise the selection
control object in an indication object. Selection of a component with a connectio
certain indication components activates also simultaneously the selection of th
indication object. The selection is not affected by the indication configuration 
priority. Notice, however, that the correct logical connection (state of the objec
always depends on the IEC 61131 configuration and the function of the indica
object cannot be controlled via the mimic.

Each valid component state, which is indicated by the binary function block inp
and undefined state(s), has an own icon description that can be freely determin
the Relay Mimic Editor.

2.2. COCB object (circuit breaker)

)LJ�������� 7KH�&2&%�FLUFXLW�EUHDNHU�GLDORJ�ER[
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The COCB object is an object which can control open and close states of circuit 
breakers, disconnectors and earth switches. The object takes care of user-defined 
interlocking logics and has a guaranteed opening and closing pulse length and forced 
open controls for protection purposes. The object can indicate both remotely and 
locally open, close and undefined states of the object. The object is mainly intended 
for CBs and it can thus pass alarm signals based on a built-in condition monitoring 
features. Maximum number of COCB objects in a mimic picture is two (2).

2.3. CO3DC object (3-state disconnector)

)LJ�������� 7KH�&2�'&���VWDWH�GLVFRQQHFWRU�GLDORJ�ER[

The CO3DC object is an object which can control open, close and earth states of 
disconnectors. The object takes care of user defined interlocking logics and has a 
guaranteed opening and closing pulse length. The object can indicate both remotely 
and locally open, close, earth and undefined states of the object. The object has 
operation time measurement as an internal condition monitoring feature. Maximum 
number of CO3DC objects in a mimic picture is two (2).

2.4. CODC object (Disconnector)

)LJ�������� 7KH�&2'&�GLVFRQQHFWRU�GLDORJ�ER[
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The disconnector object controls open and close states of CBs, disconnectors and 
earth switches (or any other device). The object takes care of user defined 
interlocking logics and has a guaranteed opening and closing pulse length. The 
object can indicate both remotely and locally open, close and undefined states of the 
object. The object has operation time measurement as an internal condition 
monitoring feature. Maximum number of CODC objects in a mimic picture is five 
(5).

2.5. COSW object (on/off)

)LJ�������� 7KH�&26:�RQ�RII�GLDORJ�ER[

The COSW object is an on/off parameter setting which can be changed both 
remotely and locally. The parameter setting is non-volatile, i.e. it sustains a device 
cold boot. For local setting the parameter has a mimic indication icon that can be 
selected and changed as any controllable object. The parameter setting value cannot 
be changed by any (direct) logic signals. Maximum number of COSW objects in a 
mimic picture is four (4).

2.6. COIND object (indication)

)LJ�������� 7KH�&2,1'�GLDORJ�ER[

The indication object is an object which can indicate both remotely and locally open, 
close and undefined states of the object. Maximum number of COIND objects in a 
10 ABB Automation
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mimic picture is eight (8).

2.7. MMIDATA object (dynamic point for numbers)

)LJ�������� 7KH�00,'$7$�GLDORJ�ER[

The MMIDATA object is a mimic interface function for dynamic data points that 
can be used anywhere in the IEC 61131-program for outputting process data to 
certain mimic locations. Location and presentation is determined in the Relay Mimic 
Editor. Maximum number of MMIDATA objects in a mimic picture is five (5).

2.8. MMITEXT object (dynamic point for texts)

)LJ�������� 7KH�00,7(;7�GLDORJ�ER[

The MMITEXT object is a mimic interface function for dynamic data points that can 
be used anywhere in the IEC 61131-program for outputting process data to certain 
mimic locations. Location and presentation is determined in the Relay Mimic Editor. 
Maximum number of MMITEXT objects in a mimic picture is five (5).
B Automation 11
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This chapter describes the usage of icons in the Relay Mimic Editor.

)LJ������ ,FRQV�GLDORJ�ER[�IRU�PDQDJLQJ�WKH�LFRQV�RI�WKH�5HOD\�0LPLF�(GLWRU

The Icons dialog box shows up to 20 icons. These icons are arranged and labelled to 
5 vertical columns aimed for the different types of dynamic objects. It must be 
noticed, that this grouping is only a recommendation; the icons may be placed and 
selected in any order. However, in order to make the default icon selection for the 
new dynamic objects to function correctly this grouping has to be maintained.

The icon size can be either 24x24 or 32x32 pixels. For dynamic objects, the icon size 
must be the same for all icons. If you change the icon size, the previous image is 
cleared. The icon size of an icon which already is in use cannot be changed, but the 
image of the icon can still be modified.

By default, a new mimic picture contains only empty icons. The easiest way to 
define the icons is to load one of the default icon sets, or to use possible self-defined 
sets, like described later in this chapter.

3.1. Editing single icons

A single icon can be modified in two ways: either by starting the image editor by 
clicking the Edit button (Figure 3.-1), or by importing an existing image by clicking 
the Load button. See chapter “Image editor” on page 16 for more information 
image editing.

To be able to import icon images, there have to be some appropriate images ex
first. Valid images are all the exported single icons (by the Save button), all th
images of the saved icon sets, and all the images of the default icon sets. The
restrictions for  importing the images are these two things: the original images
saved from this same dialog box, and the extension of the image file name is ‘

The selected icon can be saved to any folder on the disk with any name, as lo
the file name extension is ‘.mic’. The default folder for the own saved images is
12 ABB Automation
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‘\Library\User’ folder under the folder of the Relay Mimic Editor.

3.2. Icon sets

To support different needs and standards for the representations of the dynam
objects, different icon sets can be created and used. An icon set means simpl
group of all of the 20 icons.

An own icon set can be saved by the ‘Save Set’ button to any folder on the disk
only with the fixed names ‘Icon_01.mic’ ... ‘Icon_20.mic’. The default folder for t
own saved icon set is the ‘\Library\User’ folder under the folder of the Relay Mim
Editor, but it must be noticed, that due to the fixed file names only one set can
saved to one folder. Therefore it is recommended to create and use new subf

A saved icon set is taken into use simply by clicking the ‘Load Set’ button, and 
selecting the folder containing the desired set. Hint: the icon sets (also single 
exported icons) can be moved between different workstations simply by copyin
‘*.mic’ files to any folder on the other workstation.

There are also default icon sets supplied with the tool. These sets cannot be mo
by the user. A default set at a time can be loaded by clicking the ‘Default Sets
button:

)LJ�������� 7KH�GLDORJ�ER[�IRU�VHOHFWLQJ�D�GHIDXOW�LFRQ�VHW�WR�EH�XVHG��-XVW�FOLFN�DQ�
LFRQ�WR�WDNH�WKH�LFRQ�VHW�LQWR�XVH�

3.2.1. Default icon sets

The three default icon sets supplied at the moment with the Relay Mimic Edito
B Automation 13
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shown below:

)LJ���������� 7KH�GHIDXOW�LFRQ�VHWV
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This chapter describes the Relay Mimic Editor’s alarm leds.

)LJ������ 7KH�GLDORJ�ER[�IRU�HGLWLQJ�DODUP�/('�OHJHQGV

REF 54x terminals have alarm LEDs 1 through 8, all of which are freely 
programmable. Alarm LED No. 9 is the interlocking LED.

On the left side of the legends are buttons, which indicate the color of the LED.
color of any LED, other than the interlocking LED, can be changed by pressing
button repeatedly. The LED color can be one of the following:

• black

• red

• green

• yellow

The LED mode switch controls how the LED acts when an alarm occurs. The L
mode can be one of the following:

• nonlatched and steady

• latched and steady

• latched and blinking

The LED configuration can also be printed by clicking the ‘Print...’ button.
B Automation 15
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This chapter describes the Relay Mimic Editor’s image editing capabilities.

5.1. Features

The image editor is used for drawing background images and images of the ico
has basic features for editing bitmaps. The following features are found in the e

• Static texts using scaleable fonts.

• Horizontal, vertical and diagonal lines can be drawn freely with varying 
thickness.

• Scaleable filled or clear circles.

• Scaleable filled or clear rectangles.

• The Pencil tool for freehand pixel-by-pixel drawing by clicking the mouse. Od
numbered drawings of a pixel draw the pixel with the current foreground colo
while even-numbered draw the pixel with the current background color.

• Cut, copy and paste, it is also possible to copy an icon and paste it to anothe

• Zooming.

• Flip and rotate a selected area of the image.

• Flexible Undo, allows to revert to the image that was opened into the editor.

• Flexible Redo, allows to redo any Undo-operation.
16 ABB Automation
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The icons of the dynamic objects are shown on the drawing area of the image editor 
with the grey color. Although it is possible to select and use also the grey color for 
drawing in the image editor, this is not recommended. When the background image 
is saved, all the grey color is removed from the image. Thus only the black color is 
recommended for drawing the background image. It is also possible to rub off the 
icons of the dynamic objects in the image editor. This of course has no effect on the 
actual dynamic objects, and the drawing area can be redrawn by saving the 
background image from the menu item ‘Image - Update’.

The figure below illustrates editing of an icon image with the image editor. 
Compared to background image editing, the editor appears identically, except fo
B Automation 17
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drawing area size, which is smaller when editing icon images.

)LJ�������� (GLWLQJ�DQ�LFRQ�LPDJH
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5.3. Image editor menus

5.4. Image editor tool box

Table 5.3.-1 Menus and menu commands of the image editor

Menu Command Explanation

Image
Update Saves the image to the mimic picture and redraws the 

drawing area (image editor is not closed).
Save and Close Saves the image to the mimic picture and closes the 

image editor.
Close without Saving Discards the unsaved changes and closes the image 

editor.
Edit

Undo Undoes the last action.

Redo Redoes the last undone action.
Cut Copies the current selection to the internal clipboard 

and clears the current selection.
Copy Copies the current selection to the internal clipboard.
Paste Pastes the contents of the internal clipboard into the 

image.
Clear Clears the current selection.

Rotate Rotates the current selection 90 degrees counter-
clockwise.

Flip Horizontally Flips the current selection horizontally.
Flip Vertically Flips the current selection vertically.

View

Magnify Bits Toggles on or off the magnification of the bits on the 
drawing area.

Show Grid Toggles on or off the grid for the black colored bits on 
the drawing area.

Zoom In Increases the magnification of the bits.
Zoom Out Decreases the magnification of the bits.
Preview Window Toggles the visible state of the preview window for the 

drawing area.
Options

Draw from Center Toggles the draw center option. When set, the first 
mouse click after starting to draw a line, ellipse or 
rectangle defines the center of the element. When 
unset, the end/corner of the element is defined first.

Font... Opens the font chooser to allow you to change the 
active font.

Table 5.4.-1 Tool box items of the image editor

Button
Tool 
name

Explanation

Hand Moves the visible part of the image when an oversize image is on 
the drawing area. Select and drag the oversize image with the 
Hand Tool to its new position.
B Automation 19
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Dropper Replaces the current foreground and background color with a 
color that is selected from the image. To select a new foreground 
color, either click with the left mouse button (or SHIFT + right 
mouse button) on any color on the drawing area. The color you 
pick up is displayed in the foreground color box. To select a new 
background color, use the right mouse button or CTRL + left 
mouse button, the background color box indicates the selected 
color.

Selection Selects a rectangular area. Select the area by clicking the 
Selection tool and holding the mouse button down while dragging 
the pointer from one corner of the area to the opposite corner. To 
select the whole drawing area, double-click the tool.

Lasso Selects an area, which does not have to be rectangular. Choose 
the area by clicking the Lasso tool and then holding the mouse 
button down while dragging the pointer from the beginning point 
of the area to the end point.

Fill Fills an area with the foreground color.

Spray Can Draws with the foreground color using a spray pattern.

Eraser Erases the image. Drag the eraser over the area you want to 
erase. Press the Shift key before erasing to constrain the tool 
horizontally or vertically. To erase the whole drawing area, click 
the drawing area and then double-click the eraser.

Text Allows you to type text and place it in the image. Click the Text 
tool and then the drawing area. The dialog box appears. Type the 
text and click OK. The font style can be changed by choosing 
Font from the Options menu.

Pencil Draws one pixel at the time, using the foreground color by default.

Line Draws straight lines. Hold the Shift key down during the dragging 
to constrain the line horizontally, vertically or to a 45-degree 
angle.

Ellipse Draws an ellipse. Hold the Shift key down during dragging if you 
want to form a circle.

Filled 
Ellipse

Draws an ellipse filled with foreground color. Hold the Shift key 
down during dragging if you want to form a circle.

Rectangle Draws a rectangle. Hold the Shift key down during dragging if you 
want to form a square.

Filled 
Rectangle

Draws a rectangle filled with the Foreground color. Hold the Shift 
key down during dragging if you want to form a square.

Table 5.4.-1 Tool box items of the image editor
20 ABB Automation
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6. How to make a dynamic object

The making of a dynamic object starts with choosing the type of the object. The type 
of the object is chosen either by pressing one of the buttons on the object bar or by 
choosing it from Edit menu’s submenu Insert Object. More information about 
dynamic objects can be found in chapter “Dynamic objects” on page 8.

The next figure shows the configuration dialog box, when making the first dyna
object in the project.

)LJ������ 7KH�GLDORJ�ER[�IRU�FRQILJXULQJ�D�G\QDPLF�REMHFW

The dialog box has some default values. Indication connection is set to zero a
object name and selection priority are set to an unused number. All of these 
attributes are freely editable, but the object name and selection priority.

The default icons for the object type in question are selected from the active ico
Icons can be changed by pressing the button in the icon palette, if needed. The
icon set will be displayed, see Figure 6.-2. It is possible to select any of the icon
any icon of any object type, regardless of the labels of the icon sets. More 
information on editing the icons or selecting an active icon set can be found in
B Automation 21
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)LJ������ 7KH�LFRQ�VHOHFWLRQ�GLDORJ�ER[

After an icon is selected, select the OK button. The configuration dialog box wil
re-displayed and the selected icon appears in its place. Select the OK button i
configuration dialog box, when all the icons, you require, are chosen. Next, the
newly created dynamic object appers in the lower left corner of the drawing area
default, the open state icon is displayed. The object icon can be dragged anyw
within the drawing area. The grid step is 8 pixels.
22 ABB Automation
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About This Chapter

This chapter contains information on how to send customer feedback.

Customer Feedback Database

Customer Feedback is a Lotus Notes database which ABB companies can use to 
report errors, make improvement proposals and queries related to products 
manufactured by ABB Substation Automation Oy. The Customer Feedback 
database is connected to the change management system of ABB Substation 
Automation Oy, which handles all error corrections and improvements, made to the 
products.

Please note that the Customer Feedback database is primarily intended for writing 
reports about released products. If you are using for example a beta release in a pilot 
project, this should be clearly stated.

Writing A Customer Feedback Report

When writing a Customer Feedback report the following general instructions 
should be taken into consideration:

• Write the report in English.

• Write only one error report, query or improvement proposal in a Customer 
Feedback Report.

• If you are reporting an error, try to isolate the error as good as possible. Des
the sequence of events and actions causing the error. If any error messages
other debug information is provided by the system, please write it down. Incl
also information of the system, e.g. a system diagram, revision information a
configuration data.

• If you are making an improvement proposal, try to describe how the improve
function should work. Avoid providing solutions. Information about the 
importance of the improvement, e.g. number of projects that require the 
improvement, helps us to make the decision whether and when the improve
should be implemented.

To make a Customer Feedback Report, select Feedback Report from the Cre
menu. This opens an empty Customer Feedback document. Fill out the fields l
below. A question mark next to a field provides help for filling out the field.

� Subject. This should contain a short description of the issue. A more detaile
description can be given in the Description of Feedback field below.

� Type of Feedback: Comment/Improvement, Query or Complaint/Error.

� Customer Information.

� Reporting Information. This should contain detailed information about the 
product that is handled in the report.

� The person who you want to send the feedback to and whether you want to
reply from that person or not.
B Automation
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� Information related to internal handling of the report (not obligatory).

� Category.

You can issue the report by clicking the Issue Feedback button. This will send the 
report to the selected person and change its status to “in progress”.

Actions

When ABB Substation Automation Oy receives a Customer Feedback report i
analysed by a sales person or a representative of the technical support. The an
may ask for additional information in order to complete the analysis. After the 
report has been analysed, the following actions are taken:

• In case of a clear error the report is moved to the change management syste
ABB Substation Automation Oy. In this system the error is analysed in detail 
corrected in a future patch release or major release depending on the severit
impact of the error.

• In case of an improvement proposal the report is also moved to the change 
management system where it is considered as a requirement for future relea

• In case of a query an answer is provided.

When Customer Feedback reports are handled in the change management sy
the outcome can be one of the following:

No Actions This means that it is decided that the
report requires no further action. If for
example the problem is caused by a 
configuration error, it belongs to this 
category.

Will be implemented in patch/current releaseThis means that the correction or
feature will be available in the next 
official program release.

Moved to future release This means that the new feature w
be available in a new program releas
in the near future.
ABB Automation
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